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It is very important that you read these Release Notes  to ensure that you understand the features, 

fixes and enhancements that are included in each update.  To view the Release Notes for our major 

release WinBEAT 3.3.5 on 2 4 th  October 2008 go to  page 11  
 

WinBEAT 3.3.59 Release Date 16/7 /20 10 

APRA Reports 

In 2008, the Australian Securities and Investments 

Commission  (ASIC)  outlined new reporting 

requirements for DOFIs (Direct Offshore Foreign 

Insurers) and DMFs (Discretiona ry Mutual Funds) . 

The new legislation (amendment to the 

Corporations Act -  Dec 2009) requires all AFS 

licenced general insurance intermediaries to comply 

with new data collection and reporting obligations.  

All AFS  Licensee s are  required to collect and 

pro vide data in two reports :  Form 701 -  Table 1 is 

a requirement for all AFS Licensee s.  Form 701 -  

Tab le 2 is an additional report and is  only  required 

where  policies are placed with a  UFI  

The first Reporting Period is 1 st  May ï 30 th  

June 2010 and Form 701 is required to be 

lodged with APRA 40 business days from 

30/6/2010.  

Form 701 ï Table 1  reports can be submitted 

either on paper or via the APRA D2A portal.  

General Insurance Intermediaries submitting by 

paper can lodge the signed original form by mail  or 

by emailing the signed form in PDF format to APRA.  

Form 701 ï Table 2  requires  transactional level 

data for all policies placed with a UFI during the 

reporting period. This report is only  required by 

AFS Licensee s who  place policies with a UFI.  

If the AFS Licensee is required to submit both Form 

701 Table 1 and Table 2 this data must be 

submitted electronically via the APRA D2A portal.  

A new menu option has been added to Reports -   

Management Reports ï APRA Report.  

 

The Form 701 Table 1 report  can be  created in PDF 

or csv format.  The data in the csv format can then 

be copied and uploaded into APRAôs electronic 

lodgement system D2A.  

We have also included a consolidation option for 

those clients who have multiple ledgers  with the 

same AFS Licence numb er,  as only one report per 

AFS Licence can be lodged with APRA.  

You can download a copy of our WinBEAT  APRA 

Form 701 User Guide from our website  

ebix.com.au  

Custom Reports & Account Manager Se curity  

Users who have the WinBEAT Account Manager 

Security module activated can now allow users 

other than System Administrators access  to 

WinBEAT C ustom Reports. Users will only be able 

to report on their  own  clients and policies  as 

defined by the Account  Manager Security Module.   

Certificate of Currency - Security Update  

There has recently been some discussion about 

user access to the Certificate of Insurance and 

Certificate of Currency produced by WinBEAT.  

We have added new security options for Certifica te 

of Insurance forms .  The WinBEAT System 

Administrator  can now lock users from being 

able to produce a ñCertificate of Currency ò or 

ñCertificate of Insurance ò.  

Under File ï Printing Options ï Form Settings ï 

Certificate of Insurance , there are now two 

additional check box options.  

 

http://ebix.com.au/intermediary/winbeat/support


WWiinnBBEEAATT  RRee lleeaa ssee   33..33  
 

 Page 2 

Checking either or both of these boxes will block 

the selected title  being displayed in the drop list 

when users produce  a Certificate of Insurance . 

. 

If both Disable options are checked , users can only 

print a Confirmation  of Placement Cover, they will 

no longer have access to the other forms.  

WinBEAT  System Administrator s can apply 

additional security or deny a user access to the 

WinBEAT Certificate of Insurance option , via the 

User Security module.  

WinBEAT 3.3.55 Release Date 11/06 /20 10 

New Features  

ACT Workers Comp ensation  Default Insurance Fund 

Levy  

There have been changes to the requirements in 

ACT for displaying the Default Insurance Fund Levy 

on all Workers Compensation Invoices (for ACT 

only) . 

The Underwriter L evy fi eld in WinBEAT can be used 

to record the DI Fund Levy.  

An additional field has been added to the WinBEAT 

System Options which allows you to change the 

Underwriter Levy Prompt for dual use of either 

Underwriter Levy or DI Fund Levy.  

From File menu select S y stem Options  

 

Click I nvoices & Closings tab  

 

Enter the Underwriter Levy Prompt to cover both 

Underwriter Levy &/or DI Fund Levy.  Eg: UW  /  

DIF Levy  

Once updated, the prompt will be displayed on 

relevant WinBEAT forms and reports.  

The following wording i s required to print on all ACT 

Workers Compensation Invoices:  

ñThe DI Fund levy covers the cost of 

uninsured employers' claims on the Default 

Insurance Fund. This cost was previously 

incorporated into the total premium payable 

by all ACT employers and is n ow separated 

out of premium and shown as a levy.ò 

The wording may be added to your existing 

Workers Compensation schedule template or if you 

have Workers Compensation policies in multiple 

states it may be easier to create a new schedule 

template which user s may import at the time of 

invoicing ACT Workers Compensation Policies.  

If you are dealing with ACT Workers Compensation 

policies and you would like a copy of our ACT 

Workers Compensation Default Insurance Fund 

Levy Reference Guide, please email 

winbeat@ebix.com.au  

WinBEAT 3.3.53 Release Date 25/05 /20 10 

Fixes in this Release  

Cancellations  

Mid Term cancellations will now calculate the return 

premium based on the inception date entered for 

the cancellation.  

WinBEAT 3.3.51 Release Date 07/05 /20 10 

Fixes in this Release  

Closings  

Closing s will now show the correct underwriter 

when a Transfer Renewal is processed.  

Request for Cover  

You will no longer get a run time error when 

printing a Request for Cover.  

 

 

 

 

 

mailto:winbeat@ebix.com.au
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WinBEAT 3.3.50 Release Date 30/04 /20 10 

APRA Data Collection & Reporting  

WinBEAT Release 3.3.50  includes additional fields 

required to capture data for  the  APRA Reporting  

requirements .  

If you deal with any Unauthorised Foreign Insurers 

(UFI) please email winbeat@ebix.com.au  to request 

the WinBEAT APRA Data Collection and 

Reporting Requirements User Guide .  

All AFS Licensees are required to complete 

Form 701 -  Table 1 . Only those licensees 

deal ing  with U nauthorised Foreign I nsur ers 

are required to complete Form 7 01  -  Table 2.  

Additional fields have been added to capture 

transactional information for policies placed with a 

UFI on all invoices from 1 st  May, 2010 . 

The actual R eports are due to be lodged in August 

2010 and a later re lease of WinBEAT will include 

the report ing component . This Reports release of  

WinBEAT  is due around the  end of July  2010 .  

New Features  

User Signatures  

You can now add a Userôs signature to the WinBEAT 

form s that ha ve  a signature line . 

Á Client Receipt  

Á Cert ificate of Insurance  

Á Quotation Slip  

You will need to c reate an image of the userôs 

signature  in JPG, GIF or BMP format.  

The image can be no larger than 75 pixels high x 

185 pixels wide (2cm h x 5 cm wide)  

You should save the image  on the server . You can 

th en edit the User  in WinBEAT  (File ï Users) , 

browse to the signature location and add the 

signature image to the User in WinBEAT:  

 

You will then need to check the Forms have the 

Signature Line turned on.  

File ï Printing Options ï Form Settings  

Select one o f the above forms click and 

check the Signature Line option:  

 

When printing forms you will have the option of 

adding the signature to the form at time of 

printing.  

 

Fixes in this Release  

Receipting  

BPay batch is now showing on the printed 

reconciliation  report.  

Invoices  

Invoice Text field is now BOLD  

Reports 

Graphic Analysis now able to run for 20 

Underwriters (was previously limited to 14) . 

 

WinBEAT 3.3.45 Release Date 23/ 03/20 10 

Fixes in this Release  

Claims  

Claim User Fields  

The Claim User Fields can now be viewed again.  

Copy & Paste  

The right mouse click Copy & Paste function is now 

working in the Claims Payment notes area.  

WinBEAT Forms 

Statements  

The Online Payment Gateway (OPG) wording has 

been removed from Client Statements if you are 

not regist ered for OPG.  

Invoices  

Some clients experienced problems when PDF ôing 

Invoices with the remitt ance being omitted from 

the PDF, this issue has now been corrected.  

Please see the next page for full detail s of the 

WinBEAT 3.3.43 Release including Online 

Paym ent Gateway and our new Document 

Packaging module.  

 

mailto:winbeat@ebix.com.au
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WinBEAT 3.3.43 Release Date 10/03/2010  

New Features  

This release has a number of substantial e nhancements including WinBEAT Online Payment Gateway, 

Document Packaging and Multi -Risk eLink. You will find  full details of these enhancements below.  

WinBEAT Online Payment Gateway  

The WinBEAT Online Payment Gateway (OPG) allows your clients to pay their WinBEAT Invoice by credit 

card online, via your web site.  

Your customer will access a ñPaymentsò page on your web site and enter the client and invoice references  

that  are printed on their invoice. They then enter credit card details for payment of the invoice or 

statement amount, the payment is processed by the payment gateway service provider and a file is sen t 

to you to upload into your broking system to receipt those policies paid via the payment gateway.  

 

Á You select the credit cards 

you wish to allow -  VISA, 

Mastercard and /or American 

Express  

Á You select the credit card 

surcharge percentage  (if 

supported by the service 

provider) .  

Á Clients can pay a single 

invoice or their total 

outstanding  balance . 

Á You select your Payment 

Gateway Service Provider.  

We currently support:  

 Commonwealth Bank  

 eWay  

 eMatters  

 Macquarie Bank  

 NAB.  

 SecurePay  

Á Ebix develop the Payments 

pag e to match your existing 

web site .  

Á Ebix supply the Web Service 

required to connect to you r 

WinBEAT database.  

Á Suitable for Windows based 

Web servers only.  

 

 

For more information or to request the WinBEAT Online Payment 

Gateway Fact Sheet  please email winbeat@ebix.com.au . 

mailto:winbeat@ebix.com.au
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Document Packaging  Module  

The WinBEAT Document Packaging Module  allow s a user  to combine a set of documents output from a 

policy transaction with documents from an external location  for emailing direct , via  the WinBEAT print 

dia log box .  

Using Email Templates  you may  for example, automatically email invoices with add itional document such 

as an FSG, Duty of Disclosure and  / or  Privacy wordings.  

WinBEAT will initiate an email directed to the 

email ad dress recorded on the Client 

Account and create the Invoice and Policy 

Schedule in PDF Format and attach this to 

the email.  

 

Additional documents such as the FSG can be added to the Email Template and these documents will 

automatically be attached to the  outgoing email.  

Attach Documents  to the Email Template  

To attach additional documents to an email template: from the File menu select Email Templates.  

Select the required email template from the Form Type drop list.   Click  

 

Click  

You will then have t o navigate to the location where your additional documents  are saved . These 

documents must be stored on the server in a central location that all users can access.  
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Select the documents you wish to add to the template.  

 

You may need to select PDF from the  ñFiles of Typeò drop list 

 

These documents will now automatically 

attach each time this form is sent via email, 

unless the user explicitly un - ticks the 

Attachments on Email checkbox, via the 

Print dialog box . 

Automatically Send  Email  

You now also have t he option to automatically send the email .  

If this option is ticked, as soon as the email button is selected in the Print 

Dialog Box the email will automatically be sent without being displayed 

first.  You will not be able to edit the email/s prior to send ing.  
 

If this option is not ticked then the email message /s  will be displayed and chan ges can be made before 

sending.  

 

The email will be automatically sent each 

time the  form is selected to email , unless 

the user explicitly requests not to 

Automatically  Send Email, via the Print 

dialog box . 

If the email address of the client is blank the email message will be displayed, so you can manually enter 

the details, even if the Automatically  Send Email option is selected.  

 

You can email  winbeat@ebix.com.au  to request the  WinBEAT 

Document Packaging User Guide for further information about this 

module.  

mailto:winbeat@ebix.com.au
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New Multi -Risk WinBEAT eLink 

The WinBEAT eLink module has been available since 2007 and is designed to  import Client and Policy data 

from an external application such as front -end web site, your intranet or other external applications.  

The ófront endô application data is passed via the eLink interface to the WinBEAT  transaction engine and 

processed as if the transaction had been entered via a conventional WinBEAT  data entry screen.  eLink  

will  create the client record, perform  the  transaction  validations,  create accounting records and update the 

database.  

We have now enhanced the WinBEAT eLink module to allow for Co - insurance , Overseas, Multi - risk (Pack 

policies) and Multi client policy transactions.  

 

To obtain the updated  WinBEAT eLink Specification or to request an  

eLink Reference Guide please email  winbeat@ebix.com.au  

 

Other Fixe s 

WinBEAT Export  

New Fields Available  

The PDS Date  and PDS Version  have been 

added to the Invoice Export Fields available  in  the 

WinBEAT Export module.  

 

Sunrise 

Renewals & Endorsements  ð Invoice Text  

The Invoice Text  will now be carried forward to 

the ne xt transaction for Sunrise Renewals and 

Endorsements.  

 

Claims:  

Claims Outcome Notes  

Claims Outcome Notes are no longer limited to 

255 characters.  
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WinBEAT 3.3.33 Release Date 20/10 /2009  

Reports 

There was an issue with some Report s for sites 

using Branch Banking and these have now been 

fixed.  

Transaction Entry  

Multi Client Invoicing  

You now have the ability to add clients to a Multi 

Client Invoice on endorsement.  

Banking  

Reconciliation  

Some sites were getting run time errors when  

running the reconciliation report for ALL.  The ALL  

option has been replaced with an ALL option date 

ran ge From and To and is limited to any 15 month 

date period . 

WinBEAT 3.3.30 Release Date 11/9 /2009  

Reports 

Premium Sales Analysis  

There was a problem wit h the Income Received 

Report which has now been fixed.  

WinBEAT 3.3.29 Release Date 21/8 /2009  

Reports 

Premium Sales Analysis  

This Report was displaying incorrect figures when 

run for Current Period .   This has now been fixed .  

Budget Report  

This will now s how the Broker Fees correctly.  

Reconciliation  

When trying to reconcile bank óbatchesô processed 

on the same day WinBEAT was reconciling all 

óbatchesô regardless of whether they were B PAY or  

EFT batch .  This has been fixed and WinBEAT will 

now reconcile on ly the selected batch.  

Enquiry  

The premium funder name will  be displayed in the 

enquiry window again when an invoice is funded 

via the WinBEAT Premium Funding interface . 

Overseas Underwriting  - Associate GST  

A new System Option has been added to allow the 

GST for Associates to  be changed to  always 

calculate at the default GST rate , regardless of 

the GST calculated for other premium 

components.  

When ticked , this option ensures  that associate 

commission on overseas transactions will 

automatically calculate fu ll GST even if there is no 

GST on the broker commission  component of  the  

transaction.  

WinBEAT 3.3.23 Release Date 1 7/6/2009  

System Administration  

NSW SES Levy 

This release includes changes for the NSW SES 

Levy -  refer attachment sent with the 3.3.22 

Update email for full details , or download from 

www.ebix.com.au  ï Intermediary ï WinBEAT ï 

Support.  

Mandatory Fields  

There are two new Mandatory Fields available via 

System Options  -  Mandatory Fields:  

 

The WinBEAT  System Admi nistrator  can now set 

the Transaction entry -  ñCancellation Code ò and 

the Reverse Receipt or Payment -  ñReason for 

Reversal ò to be mandatory fields.  

WinBEAT Registration 

The WinBEAT warning message to advise when 

your  registration will expire is now only seen by 

WinBEAT System Administrators.  

Document Printed Message  

The WinBEAT print dialog box will now display a 

message to show when a print job is completed, 

similar to that displayed when a user PDFs forms 

or reports .  

 

Transaction Entry  

Pro Rate 

The Pro  Rate button now calculates based only 

the premium components entered.  

Transaction Locking  

A number of diagnostic errors were being created 

by transactions being amended at the same time 

as being receipted.  We have n ow introduced 

additional transaction locking to avoid these 

diagnostic errors.  

Sunrise Transaction Entry  

A lock has been introduced in Sunrise Transaction 

Entry so that only 1 person at a time can post 

closings to Sunrise.  

http://www.ebix.com.au/
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Banking  

Client Receipts  

You wil l no longer be able to process a negative 

client receipt in WinBEAT.  

Client Receipts now additionally display the 

invoice inception date . 

Net Associate Receipts.  

All invoices can now be net receipted by 

Associate, regardless of whether they have an 

Associ ate balance or not.  

Automated Banking ð Warning  

If a user reverses a payment that was processed  

via Direct Entry (ABA File) , after the bank file 

including that transaction has been created, the 

following warning will display:  

 

Credit Payments  

If a user pr ocess es an underwriter or associate 

payment as a credit amount the following warning 

will display:  

 

IBA Enquiry  

The type of  EFT or  credit card rece ipt will now 

display in IBA Enquiry as EFT, EFT Batch or EFT 

Batch CCard.  

Reports 

Premium Sales Analysis  

A number of changes have been made to the 

Premium Sales Analysis Report  ensuring you no 

longer get óUndefinedô transactions or runtime 

errors.  

 

 

 

 

 

Custom Reports  

Now includes Client Cross Reference  

Diary  

Diary Follow ups will now appear in follow up date 

order.  

WinBEAT 3.3.18 Release Date 19/3 /2009  

Aged Outstanding Premium Listing  

This will now display t he commission and fees 

only when selected and will display the EX GST 

amounts correctly.  

Custom Reports  

You will no longer encounter a Run Time Error 

when  adding a filter in Custom Reports.  

WinBEAT 3.3.13 Release Date 23/1/2009  

Aged Outstanding Premium Listing  

This will now report the correct figures for a 

selected Account Manager when other than ALL 

BALANCES is selected.  

WinBEAT Forms 

Endorsement Schedule s 

Schedules on endorsements will print depending 

on what System Option is selected.  

 

 

 

 

 



WWiinnBBEEAATT  RRee lleeaa ssee   33..33  
 

 Page 10 

WinBEAT 3.3.11 Release Date 12/12/2008  

Screen Resolution  

We have increased the font size by 2 points on all 

the WinBEAT screens  to compensate for the new 

screen resol ution.  

Printing  

Change printer - Vista  

The inability to change printers on Windows Vista 

has now been fixed. The  button is 

now available in all Print dialog boxes.  

Cancel Print Dialog Box  

If the user click ed  or  before 

WinBEAT finished printing it wa s causing WinBEAT 

to freeze or crash. This has now been fixed.  

If users click  or before the print job 

is finished nothing will happen. The user will have 

to click again once printing is completed . 

WinBEAT Forms 

The fold marks have been adjusted on all C lient 

Forms to allow for the additional óTrading As ô line 

in the client address. The fold marks are based on 

DL8 window faced envelopes.  WinBEAT 3.3.10 

Release Date 18/11/2008  

Maintain  Clients  

Maintain Clients has been fixed and you will no 

longer get a ru n time error when adding or 

amending client accounts.  

WinBEAT 3.3.9 Release Date 17/ 11/2008  

WinBEAT Forms 

Claims Follow -up  

The Claim Acknowledgement and Claim Follow -up 

forms were printing the Client address twice. This 

has now been fixed.  

Claims Notific ation  

The Underwriter Clam Number now prints in the 

correct location.  

Client Statement  

The Client Statement -  Automatic selection will 

now sort correctly in Account Manager then Client 

Code order.  

Banking  

Client Payments  

When refunding a client from unall ocated cash an 

error would occur when printing the remitt ance.  

This has now been fixed.  

Reconciliation  

BPAY and EFT Batch Transactions can now be 

selected for reconciliation  

Reports 

The Aged Debtors Report will now report all 

balances for extracted client s when reporting on 

overdue policies.  

Enquiry  

You can now search by ñTrading Asò name without 

getting an error.  

Sunrise 

Sunrise Lapse 

A Sunrise Lapse transaction was causing an error 

when coming back into WinBEAT. This has now 

been fixed.  

Database Services  

When Merging and Deleting clients the Contacts 

and Addendum are now merged onto the Master 

Client.  
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Introduction  

WinBEAT Release 3.3 Release Notes 

contain the details for  all the 

enhancement s and new features and 

functions  in this new version of 

WinB EAT. 

The WinBEAT System Administrator 

should encourage a l l users to read 

the Release Notes to ensure they 

are aware of changes to existing 

functional ity as well as the new 

features in this new release.  

The changes and enhancements in this 

release are predo minantly driven by 

requests and suggestions from our 

4,500 users across Australia , as well as 

advances in technology that have taken 

place over the last 18 months.  

WinBEAT Release 3.3 includes support 

for our new iClose ACORD based e -

commerce solution.  Eb ix will be 

releasing iClose modules throughout 

2009.  

WinBEAT 3.3 Workshops 

The WinBEAT 3.3 Workshops will be run 

in each capital throughout November. 

The workshops run for three hours and 

are designed to fast - track you through 

all of the changes in this re lease and 

how they may be implemented in your 

business. Your workshop invitation will 

arrive in October for the following dates:  

Melbourne  Tuesday 28 th  October  

Sydney  Thursday 6 th  November  

Adelaide  Wednesday 12 th  November  

Brisbane  Tuesday 18 th  November  

Perth  Tuesday 25 th  November  

WinBEAT 3.3 Training 

We will be training this new version 

throughout October and November and 

into 2009.  We recommend that 

WinBEAT System Administrators attend 

our óUpgrade to WinBEAT 3. 3 for 

System Administrators ô course for an in -

depth look at all the changes and 

enhancements and how they can be 

utilised within your business to increase 

efficiency, improve reporting standards 

and help you to provide superior 

customer service. Course outlines, dates 

and locations can be found  on our web 

site:  

www.winbeat.com.au  

WinBEAT 3.3 Key Features  

Á Minimum Screen Resolution now 1024 x 768  

Á Multi -Client Invoices  

Á Two Associates (Sub - intermediaries) on an Invoice  

Á Account Manager at Policy level  

Á New Diar y Functionality  

Á Cancellation Code on Transactions  

Á Required Fields now User Defined  

Á New Reports:  

 Premiums Received  

 Cancellation Reports  

 GST Free Report  

Á Client Cross Reference Field  

Á Email Templates  

Á Client Manual via WinBEAT Export  

Á DOFI flags and Reporting Re quirements  

New Minimum Screen Resolution  

With the advent of 20ò flat panel monitors as standard, 

WinBEAT Version 3.3 will require a min imum screen 

resolution of 1024 by  768. Increasing the resolution allows 

us to fit more information on the screen and exte nd forms 

and dialog boxes to display existing fields in full.  

Multi -Client invoices  

The new Multi -Client Invoice functionality in WinBEAT 

Release 3.3 allows users to have more than one Client on 

an Invoice . Multi -Client Invoice allows you to create a 

ômasterô invoice from a number of sub invoices, each for a 

different client. It is designed for Body Corporate or 

Franchise situations where there are a number of clients 

paying a proportion of a single policy.  

Multiple Associates  

Sub - intermediaries have been r e-named to ñAssociatesò as 

they can be Agents, Authorised Representatives , Brokers or 

Referrers. We have now allowed for two Associates to be 

allocated commission on an invoice. This means you  can 

split commission between two external parties.  

WinBEAT Clie nt Insurance Manual  

WinBEAT Export now allows you to Export a number of 

policies into a single document. This will prove useful for 

creating Client Insurance Manual using your own particular 

document style.  

WinBEAT Diary and Calendar  

The WinBEAT Diary modu le is a new option available by 

registration , at 3% of your base support rate . The Diary 

allows users to optionally automate follow -up reminders for 

Renewals and New Business, Quotes, Claims, part receipted 

items and compliance requirements. Users can also  set up 

user defined diary items as required. The Diary has a 

Calendar view and an Item view which provides filtering on 

Client, Policy or Claim entries. Users can add both public 

and private entries into their diary.  

http://www.winbeat.com.au/
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System Administrator  Notes  
The WinBEAT System Administrator  is responsible for the set -up of new features and maintenan ce of the 

WinBEAT database  and options . Our System Administrator notes are designed to  assist with setting up 

new  features and understanding new System warning messages.  

Minimum Screen Resolution ð 1024 by  768 

With t he advent of 20ò flat panel monitors as standard, WinBEAT Version 3.3 now requires a minimum 

screen resolution of 1024 by  768. Increasing the resolution allows us to fit more information on the 

screen and extend forms and dialog boxes to display existing f ields in full.  

To check your screen resolution simply right mouse click on the desktop and select properties  

 

Select the Settings tab and ensure your Screen resolution is set to 1024 by 768 as a minimum. Of course 

you can set it higher if you wish to.  
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Database Information  

A new function has been made available from the Help menu that will display database information.  

From the Help menu select About WinBEAT.  

Click  

A dialog box similar to the following will be displayed:  

 

The Database size and database  log file size are displayed, along with their locations. Table information is 

also displayed so our helpdesk can check the size of the schedule file or the policy file if there are any 

technical issues with your database.  

Sub-Intermediary  renamed to òAssociate ó 

Sub - intermediaries have been re -named ñAssociatesò as they can be Agents, Authorised Representatives, 

Brokers or Referrers.  Any reference within WinBEAT to Sub - intermediary has been  changed to Associate.  
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New  System Options  

WinBEAT Release 3. 3 has quite a number of new System Options. These relate to some of the new 

features that we have incorporated into this version and will need to be checked as soon as you have 

completed the upgrade process.  

Control Tab  

From the File menu select S y stem Options. T he Control Tab will be displayed :  

Two new options are available :  

Lock Bank Account:  In relation to  the Automated Banking and Macquarie Premium 

Payments modules  there is a new option to ñLock Bank Account. 

 If the Lock Bank Account option is ticked , o nce t he Bank Account 

Details have been entered for a Client, Underwriter, Associate or 

Funder they will not  be available fo r editing by any user other tha n 

the WinBEAT System Administrator.  

 

Client Trading Name on Forms:  Many of our users have requested that w e print the ñTrading Asò 

name (previously Registered As) on Client Forms (Invoice, 

Statement, Certificate, Receipt etc.). This option can be activated by 

ticking the Client Trading Name on Forms  checkbox, as required.  
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Note that the ñRegistered Asò field o n the Client Card has been changed to ñTrading Asò 

 

 

 

Broker Details Tab 

Both the WinBEAT Automated Banking Module and Macquarie Premium Payments Module now allow 

transfer of income (Bank ï Payments ï D raw Income) to the working account via Direct Entry . This 

means your income transfer will be included in the ABA file that is uploaded to the bank for processing 

payments. Simply recording your bank details will ensure WinBEAT includes draw income pa yments as 

part of the ABA file.  
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Invoice and Closings Tab 

If you are using ñClient Adviceò in WinBEAT as part of your Compliance requirements you can now ensure 

that the Invoice Advice is automatically printed on a new schedule page.  

To do this , simply select the I nvoices and Closings tab and tick the Print Adv ice on New Pag e checkbox 

option.  
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GST & Overseas 

GST Payments can now be included in the ABA file for  the Automated Banking and MPP modules. This 

means the transfer of GST from your trust account into your GST holding account can be automated as it 

is inc luded as part of the ABA file that is uploaded to the bank.  

In System Options select the GST & Overseas tab and complete the details for your GST holding account.  

 

Mandatory  Fields Tab 

An entirely new component has been added to the security module of Win BEAT that allows the System 

Administrator to make the Compliance Fields in WinBEAT mandatory.  

This means users MUST complete the fields before they can save the Client Account or the Invoice 

Transaction.  

From the File menu select S y stem Options.  

Click the Mandatory Fields tab.  

 






































































































































































































